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2. Click on the shape you 
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and choose the icon needed 
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Insert > Icons

3. Click on the Format 
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choose Crop  option to 
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composition of your icon.

4. Click on the drop down 
arrow and choose Fit  to fit 
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icon, first delete it. Only use 
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icon library: Insert > Icons. 
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FY25 performance 

Strategic combination with Eastdil Secured 

Á{ǘǊƻƴƎ C¸нр ǊŜǎǳƭǘǎ ƘƛƎƘƭƛƎƘǘ DǊƻǳǇΩǎ ǊŜǎƛƭƛŜƴŎŜ ŀƴŘ ŀŎŎŜƭŜǊŀǘƛƴƎ ƳƻƳŜƴǘǳƳ

ÁTransactional business capitalised on increasingly positive market dynamics toward the end of the 
year, delivering a very strong Q4

ÁLess Transactional business delivered robust growth in revenue and profits

Á Improved profitability driven by operational leverage and benefits of prior year restructuring, 
supporting increase in dividend 

ÁAcquisition of pre -eminent Real Estate Investment Banking (REIB) business with complementary 
global footprint and culture, in line with Group strategy

ÁPositions Savills as global leader in real estate advisory,  and  significantly strength ens ǘƘŜ DǊƻǳǇΩǎ 
competitive position in North America

ÁEnterprise value of £827m with consideration of £685m funded through debt and the issue of new 
ordinary shares to Eastdil {ŜŎǳǊŜŘΩǎ owners, including employees, providing strong alignment

ÁFinancially compelling with low -to -mid teens EPS accretion in 2027 (pre -synergies);  low teens 
unlevered ROIC (1) (pre -synergies) in medium term ; high teens Group ROCE (2)  by 2028, escalating 
thereafter;  and strong cash generation

(1) Unlevered ROIC defined as enlarged Group incremental underlying net operating profit after tax / Eastdil {ŜŎǳǊŜŘΩǎ enterprise value.
(2) ROCE defined as enlarged Group underlying EBIT / (average shareholder funds plus average gross debt).
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£m unless otherwise stated FY25 FY24 Change

Change in 

constant currency

Revenue 2,550.9 2,404.0 +6.1% +7.5%

Underlying EBITDA (1) 214.9 194.3 +10.6%

Underlying profit before tax 145.3 130.4 +11.4% +12.1%

Underlying profit before tax margin 5.7% 5.4% +30 bps

Underlying basic earnings per share 77.2p 66.2p +16.6%

Dividend  per share 33.8p 30.2p +11.9%

Cash flows from operating activities 202.7 177.3 +14.3%

Net cash (as at 31 December) 167.7 176.3 (4.9)%

Strong growth in earnings driven by increase in 
revenue and efficiency gains
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(1) Underlying EBITDA defined as EBITDA before Exceptional Items ς see appendix for reconciliation to reported profit
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26%

12%

21%

37%

4%

Commercial Transaction Advisory

Residential Transaction Advisory

Consultancy

Property & Facilities Mgmt

Investment Management

£m unless otherwise stated FY25 FY24 Change

Commercial Transaction Advisory 672.6 659.9 +1.9%

Residential Transaction Advisory 293.6 269.7 +8.9%

Total Transactional 966.2 929.6 +3.9%

Consultancy 546.6 492.3 +11.0%

Property & Facilities Mgmt 943.3 888.1 +6.2%

Investment Management 94.8 94.0 +0.9%

Total Less Transactional 1,584.7 1,474.4 +7.5%

Total Group Revenue 2,550.9 2,404.0 +6.1%
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Group underlying profit before tax up 11.4%
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£m unless otherwise stated FY25 FY24 Change

Commercial Transaction Advisory 24.9 25.7 -3.1%

Residential Transaction Advisory 22.2 15.9 +39.6%

Total Transactional 47.1 41.6 +13.2%

Consultancy 47.5 39.9 +19.0%

Property & Facilities Mgmt 52.2 49.2 +6.1%

Investment Management 13.9 10.1 +37.6%

Total Less Transactional 113.6 99.2 +14.5%

Unallocated costs (15.4) (10.4) -48.1%

Total Group Underlying Profit 
Before Tax (1) 145.3 130.4 11.4%

15%

14%

30%

32%

9%

Commercial Transaction Advisory

Residential Transaction Advisory

Consultancy

Property & Facilities Mgmt

Investment Management

(1) See appendix for reconciliation to reported profit before tax
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Revenue Underlying profit before tax

£m unless otherwise stated FY25 FY24 Change FY25 FY24 Change

EMEA 1,501.8 1,386.5 +8.3% 121.2 107.9 +12.3%

Margin 8.1% 7.8% +30bps

Asia Pacific 716.7 702.6 +2.0% 33.6 29.6 +13.5%

Margin 4.7% 4.2% +50bps

North America 332.4 314.9 +5.6% 5.9 3.3 +78.8%

Margin 1.8% 1.0% +80bps

Unallocated costs (15.4) (10.4)

Total Group 2,550.9 2,404.0 145.3 130.4

EMEA

ÁRevenue growth across all business areas, with 
strong UK Q4 performance

ÁTransactional revenues driven by continued 
expansion in Middle East, significant growth in 
Spain & UK and good performance of recent 
acquisitions

ÁLess Transactional growth across most areas of 
Consultancy & Property Management, including 
key contract wins in Germany, Spain, Middle East

Asia Pacific North America

ÁRevenue growth driven by Singaporean & Indian 
Consultancy

ÁCommercial Transactions Advisory revenues down 
12% (Australian investment, Japan, China); Hong 
Kong improved

ÁResidential Transaction Advisory growth in 
revenue and margin

ÁTransactional revenue up following strong growth 
in Industrial Leasing, and growth of Global 
Occupier Services and Savills Canada

ÁContinued expansion of Consultancy o ffering with 
acquisition of Hoffman (Move Management) and 
strong performance from Location Strategy 
Consulting
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£m unless otherwise stated FY25 FY24 Change 

Underlying profit before tax 145.3 130.4 +11.4%

- Amortisation (8.8) (9.2)

- Impairments (4.6) (1.9)

- Share based payments (0.6) 1.1

- Gain on disposals 4.5 -

- Restructuring (30.5) (17.2)

- Transaction related costs (3.6) (15.9)

- Fair value adjustments (0.7) 1.0

Reported profit before tax 101.0 88.3 +14.4%

Underlying basic EPS 77.2p 66.2p +16.6%

Reported basic EPS 52.0p 39.4p +32.0%

Dividend per share 33.8p 30.2p +11.9%
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Momentum across global real estate markets with growth forecast 
across all regions for FY26

Group continues to build strong commercial pipelines

Residential market in UK will be impacted by consumer confidence and 
wŜƴǘŜǊǎΩ wƛƎƘǘǎ !Ŏǘ

Less Transactional businesses expected to deliver growth in - line with 
strategy

Group remains focused on cost management and driving operational 
leverage 

Expect to deliver improved performance in FY26, supported by more 
positive transactional market 

Too early to call the potential impact of the Middle East situation
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Our  vision  is to  be  the  real  estate  advisor  of  choice  in  the  prime  commercial  and  residential  markets  we  
serve,  recognised  for  global  leadership  and  the  quality  of  our  insights  and  advice . 

We support  investors,  businesses  and  individuals  to  optimise  their  real  estate  performance  across  the  full  
investment  and  occupational  lifecycle .

How we deliver this

An uncompromising 
commitment to the 

highest standards of 
service

Broad service lines 
and global reach 

across key markets

Relentless 
client focus 

Scale and 
diversification 

Leading positions in 
prime investable 

markets

Global leadership 
in core segments 

Collaborative teams 
with aligned 

incentives attracting 
top -tier talent

High -performance 
culture 

Strategic investment 
to drive sustainable 
long -term growth

Disciplined 
capital allocation 

Helping people thrive through places and spaces
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Real Estate Investment 
Banking & Transaction 

Advisory 
Acquisition Advisory

Disposal Advisory & Recaps

Residential Sales

Leasing

Strategic 
Advisory & 

M&A

Debt Financing

Valuations 

Technical Due Diligence

Development / Planning

Building & Project Consultancy / Project Management

Housing / Professional Services / Other

Investment Management

Property & Facilities Management

Consultancy

Margin potential Revenue volatility



HOW TO INSERT 
AN ICON

2. Click on the shape you 
wish to add your icon to 
and choose the icon needed 
from the PPT Icon Library.
Insert > Icons

3. Click on the Format 
Picture/Format Graphic 
tab in the ribbon and 
choose Crop  option to 
edit the position and 
composition of your icon.

4. Click on the drop down 
arrow and choose Fit  to fit 
the icon to the placeholder.

1. To replace an existing 
icon, first delete it. Only use 
icons from the PowerPoint 
icon library: Insert > Icons. 

G
R

O
U

P
 S

T
R

A
T

E
G

Y
 

Establish position as Global Leader 
in Real Estate Investment Banking

ÁAttractive premium segment of Transaction 
Advisory 

ÁScale and complexity typically commands higher 
margin

ÁDebt advisory generates longer term, repeatable 
revenues

ÁBuilds trusted partnerships with leading real estate 
investors early in their investment decision -making

Á{ǘǊŜƴƎǘƘŜƴǎ DǊƻǳǇΩǎ ŀōƛƭƛǘȅ ǘƻ ƻŦŦŜǊ ŎƭƛŜƴǘǎ 
comprehensive solutions (e.g. M&A / 
Recapitalisations etc.), including in high growth 
sectors (e.g. Data Centres)

Continued growth of Less 
Transactional businesses

Top strategic priorities

14

ÁLess Transactional businesses underpin Group 
earnings

ÁLess volatile, more resilient revenue stream

ÁGrowth supplemented by selective investment in 
new geographies and complementary service 
lines

ÁProperty Management strengthens client 
relationships; enhances asset knowledge; and 
delivers useful data streams

ÁConsulting services create a pipeline of 
transactional activity (e.g. Development Advisory 
/ Location Strategy)



HOW TO USE 
BULLET POINTS

3. If you want to remove 
them, just click the Decrease 
List Level button.

1. If you want to use your pre -
formatted bullets, click on the 
Increase List Level button.

2. To indent your bullets 
to the next level, click on  
Increase List Level again .

HOW TO INSERT 
A TABLE

1. To use the table we have 
designed for you, click on the 
table and go to Table Tools > 
Format in the top ribbon. 

2. You can choose to 
delete or insert more rows 
and columns to your table 
to suit your content.

3. You can either copy old 
content from another table or 
type straight into this one.

We have designed and created 
a table for you. This can be 
found on the table slide when 
you open your template.

You can insert the default 
table design into the 
placeholder.

1. Click on the icon in the 
middle of the placeholder 
and choose the amount of 
rows and columns you need.

3. You can also use tools 
on the Layout tab to 
evenly distribute your 
rows and columns.

2. Use the other table style 
options to design the table 
to how you need it.

HOW TO USE 
BULLET POINTS

3. If you want to remove 
them, just click the Decrease 
List Level button.

1. If you want to use your pre -
formatted bullets, click on the 
Increase List Level button.

2. To indent your bullets 
to the next level, click on  
Increase List Level again .

HOW TO INSERT 
A TABLE

1. To use the table we have 
designed for you, click on the 
table and go to Table Tools > 
Format in the top ribbon. 

2. You can choose to 
delete or insert more rows 
and columns to your table 
to suit your content.

3. You can either copy old 
content from another table or 
type straight into this one.

We have designed and created 
a table for you. This can be 
found on the table slide when 
you open your template.

You can insert the default 
table design into the 
placeholder.

1. Click on the icon in the 
middle of the placeholder 
and choose the amount of 
rows and columns you need.

3. You can also use tools 
on the Layout tab to 
evenly distribute your 
rows and columns.

2. Use the other table style 
options to design the table 
to how you need it.

Other medium term strategic priorities
G

R
O

U
P

 S
T

R
A

T
E

G
Y

 

15

ÁScale platform to support high -
conviction discretionary funds and 
mandate -based products

ÁFocus on clearly defined sectors of 
expertise, including Living, Logistics 
and Development & Construction 
Finance

ÁProvide asset management services 
for non -discretionary private equity 
investors (as local operating partner)

ÁExplore growth opportunities in North 
America in due course

Grow Savills Investment 
Management

ÁScale and enhance profitability of 
existing U.S. business, broadening 
sector coverage of Industrial & 
Logistics, and growing Retail

ÁExpand leading market position across 
Iberian Peninsula and continue growth 
trajectory in Italy

ÁScale Property Management across 
CEME (e.g. Germany & France)

ÁStrengthen core markets in Australia, 
Japan and India, while driving for 
operating efficiencies in Sino -markets

ÁBroaden suite of global Consulting 
Services (e.g. Project Management)

Systematically build leading 
positions in key markets 

ÁLeverage market -leading prime and 
super prime residential and 
development expertise, and global 
connectivity 

ÁStrengthen and scale positions in 
important global markets, particularly 
Continental Europe

ÁExpand selectively into other 
attractive prime and super prime 
global markets 

ÁDeepen engagement with global 
private wealth and family offices via 
Savills Private Office

Continue development of global 
prime residential platform
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Business area Key drivers
Key performance 
indicator 

Current underlying 
PBT margin

Target underlying 
PBT margin

Transaction Advisory
Á Positioned for market recovery

Á Significant operational capacity / leverage

Ψ¢ƻǇ оΩ ƳŀǊƪŜǘ ǎƘŀǊŜ 
in our target markets 

4.9%
10%+ 

(Pre -combination with 
Eastdil Secured)
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a
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Consultancy

Á Expansion by geography and service 
offering 

ÁMarket share gains

Average revenue 
growth of c.10% p.a. (1)

8.7% c.10%

Property & Facilities 
Management

5.5% 4.5% to 6.0%

Investment 
Management 

Á Scale business 

Á Expansion of service offering and leverage  
sectoral expertise

ÁOperational leverage

Investment 
performance: >65% of 
products 
outperforming 
benchmark 

14.7% 20%+

(1)  2015 to 2025 Less Transactional revenue CAGR of 9.1%
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Strong cashflow generating business with economic cycle resilient business mix

Á Low financial leverage - underpinned by Less Transactional resilient earnings
Á Net debt/EBITDA
ς Ordinarily c.1x or less (1)

ς Opportunistically > 1x (e.g. to finance cash -generative acquisitions)
Á Diversity of debt sources/maturities/currencies

Consistent financial 
strength and flexibility

Á Capital light model with strong cash conversion 
Á Platform, people and technology

Invest to drive 
organic growth

Á Strong strategic, cultural and service line fit
Á Financially compelling
ς ROIC > WACC
ς EPS accretive and attractive stabilised ROCE

Targeted M&A

Á Progressive ordinary dividend supported by Less Transactional earnings
Á Supplemental dividend supported by Transactional earnings
ÁMaximum total dividend: higher of 1.5x/2.0x cover on statutory/underlying EPS
Á Consider return of outperformance driven surplus capital via share buybacks

Maintenance of 
attractive shareholder 

distribution policy 

Delivering strong shareholder returns ς averaged > 10% (2)  p.a. since 2007

(1) As at 31 December 
(2) Assumes dividend reinvested for comparability.



Acquisition of 
Eastdil Secured03
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FIRST-CLASS 
GLOBAL 

PLATFORM

Compelling strategic and financial rationale

19

Highly 
complementary 
business models 

Á.ǊƛƴƎǎ ǘƻƎŜǘƘŜǊ ƘƛƎƘƭȅ ŎƻƳǇƭŜƳŜƴǘŀǊȅ ǎŜǊǾƛŎŜ ƭƛƴŜǎ ǇǊƻǾƛŘƛƴƎ ŀƴ ŜƴƘŀƴŎŜŘ ǎŜǊǾƛŎŜ ǘƘŀǘ ǎǳǇǇƻǊǘǎ ƻǳǊ ŎƭƛŜƴǘǎΩ ǊŜŀƭ ŜǎǘŀǘŜ 
needs through the full lifecycle of their investments

Á Expected to generate direct revenue synergies of at least £60m revenue and £15m  EBITDA p.a. over the medium term

Accelerated   
growth

Á Significant momentum building in global real estate market activity supported by market fundamentals  

ÁWall of commercial real estate debt maturity driving Debt Advisory

Attractive  
financial impact

Á Significantly earnings enhancing with low -to -mid teens EPS accretion in 2027 (pre -synergies)

Á Attractive returns with low teens unlevered ROIC (1) (pre -synergies) in medium term, meaningfully ahead of WACC; high 
teens ROCE (2)  by 2028, escalating thereafter

Á Strong cashflow generation supports de -leveraging

Eastdil {ŜŎǳǊŜŘΩǎ     
attractive market 

positioning

Á Eastdil Secured is a leader in the attractive Real Estate Investment Banking market and has a blue -chip investor client 
base 

ÁWith higher -margin transactional revenues, including longer term repeatable income streams from debt advisory, Eastdil 
Secured has demonstrated resilient profitability and strong cash generation across market cycles

Á Positions Savills as a global leader in real estate capital markets advisory services

Á¢ǊŀƴǎŦƻǊƳǎ ǘƘŜ DǊƻǳǇΩǎ ŎƻƳǇŜǘƛǘƛǾŜ ǇƻǎƛǘƛƻƴƛƴƎ ƛƴ bƻǊǘƘ !ƳŜǊƛŎŀΣ ŎǊŜŀǘŜǎ ǎȅƴŜǊƎƛŜǎ ƛƴ 9a9!Σ ŀƴŘ ǇǊƻǾƛŘŜǎ ŀ ǇƭŀǘŦƻǊƳ ŦƻǊ 
growth for Eastdil Secured in Asia Pacific

Creates 
a global leader

(1) Unlevered ROIC defined as Group incremental underlying net operating profit after tax / Eastdil Secured enterprise value.
(2) ROCE calculated as enlarged Group underlying EBIT / (average shareholder funds plus average gross debt).

Á Strong cultural fit and an exceptional, committed and incentivised leadership team, with a strong track record across 
market cycles 

Á Client focused and performance driven culture from the ground up across both businesses
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ÁSavills to acquire Eastdil Secured for an enterprise value of US$1,112.5m (£827m), translating into a total consideration of 
$921.25m (1) (£685m) of which:

Á$368.50m (£27 4m) will be satisfied through the issue of new ordinary shares in Savills (2) όά/ƻƴǎƛŘŜǊŀǘƛƻƴ {ƘŀǊŜǎέύ

ÁϷррнΦтрƳ όϻпммƳύ ǿƛƭƭ ōŜ ǇŀȅŀōƭŜ ƛƴ ŎŀǎƘΣ ŦǳƴŘŜŘ ǘƘǊƻǳƎƘ ŀ ƴŜǿ ϷуллƳ όϻрфпƳύ ŘŜōǘ ŦŀŎƛƭƛǘȅ όάbŜǿ CŀŎƛƭƛǘȅέύ

ÁPost completion, Eastdil {ŜŎǳǊŜŘΩǎ existing equity holders will collectively hold c.16% of enlarged Savills share capital (3)

Ác.6.3% will be held by 85 Eastdil Secured senior employees, who will be subject to staged lock -up provisions extending 
to 4 - 6 years

ÁThe current institutional owners of Eastdil Secured will hold shares that will be subject to customary lock -up provisions 
over a 12 - 18 month period: Temasek ( 4 .0%), Guggenheim Investments (5.0%) and Wells Fargo (0.5%) 

ÁEnterprise value represents a multiple of 9.9x Eastdil {ŜŎǳǊŜŘΩǎ 2025 underlying EBITDA of $113m (£84m) (4)

ÁExpected closing in Q2/Q3 2026, subject to customary closing conditions

(1) Total consideration is equal to the enterprise value of $1,112.5 million, less Eastdil {ŜŎǳǊŜŘΩǎ existing debt of $191.25 million.
(2) Total number of Consideration Shares is calculated based on the volume weighted average price of Savills shares of 990 pence for  the last 20 trading days ended on 10 March 2026 .
(3) Based on issued share capital as at last practicable date.
(4) U.S. GAAP basis.
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Global Real Estate Deal Volumes (2021- 2025) for Assets of $100m+ ($bn)
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No.1 US adviser on $100m+ transactions and global top 2 player

The combination creates a global leader in Real Estate Capital 
Markets and Advisory

Source: MSCI Real Capital Analytics (2021 ς 2025), share of brokered equity sales transactions  >$100m ς global ranking refers t o N. America, Europe & Asia Pacific.

Total Global Real Estate Volumes 2021 -2025 ($bn)

1
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a platform for enhanced growth and profitability
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Standalone total revenue FY25 Enlarged Group pro - forma total revenue FY25

EMEA North America APAC

Á Transforms Savills position in 

North America

Á άIŀƭƻ ŜŦŦŜŎǘέ ƻƴ {ŀǾƛƭƭǎ ƎǊƻǿǘƘ 

plans in North America

Á Accelerates Eastdil {ŜŎǳǊŜŘΩǎ 

growth outside of North America

Á {ǳǇǇƻǊǘǎ ŜƴƭŀǊƎŜŘ DǊƻǳǇΩǎ 

leading position in EMEA

Á First class global platform

Á A leading position in all regions combined with in -

depth local expertise

£0.5bn £2.6bn £3.0bn

Pro -forma

24%

76%

59%
28%

13%
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Eastdil Secured: The pre- eminent Real Estate Investment Bank 
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Eastdil {ŜŎǳǊŜŘΩǎ business highlights
Global Real Estate 

Investment Banking Platform

Servicing a broad, diverse and global client base of 
the most sophisticated real estate and digital 

infrastructure owners and investors

US adviser on large, 
transactions (1)

#1

Transaction volumes 
(2011 ς 2025) (2)

$3.0tn

Average annual 
transaction volume (3)

$200bn

Strong track record - 
established in 1967 

59 years
Client facing 

professionals  across 20  
offices

c.450
Managing Directors with  

>50 having 10+ years 
tenure

80

#1

U.S. debt placement 
adviser in Average Loan 

Size (5)

#1
Revenue split by 

equity/debt advisory 
FY25

58%/42%

Revenue split between 
US/EMEA

FY25 

76%/24%

Revenue FY25
(£470m) 

$633m

Average underlying 
EBITDA margin (6)  

18%

M&A

Cont. 
Vehicles 
κ W±Ωǎ

Property 
Sales

Debt 
Advisory

Structured 
Credit

Loan
Sales

Capital 
formation

Corporate 
Finance

Capital 

Markets 

Expertise
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Capital Markets capabilities of a premier Wall Street 
firm across all real estate asset classes

US Data Center  sales 
ŀƴŘ W±Ωǎ(4)

2

(1) MSCI Real Capital Analytics (2021 ς 2025) share of brokered U.S. real estate equity sale transactions >$100m. 
(2) Eastdil Secured internal estimates.
(3) From 2011 -2025, excluding 2020 (Covid interruption). Based on Eastdil Secured internal estimates. 

(4) Green Street News Real Estate Alert, broker share of Date Center  properties in 2025 (deals >$25m).
(5) Mortgage Bankers Association. Reflects all property type U.S. debt placement 2021 -2024. Avg  loan size excludes lending 

and servicing platforms
(6) Eastdil Secured financial performance between 2021 -2025, weighted average.
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ÁEastdil {ŜŎǳǊŜŘΩǎ business is focused on large portfolio and 
complex M&A transactions

Á This combination of scale and complexity generally commands 
higher fees and drives higher margins

Á The debt advisory element of REIB generates longer term 
repeatable income streams reflecting the ongoing and 
predictable real estate financing cycle 

Eastdil ÂğĕƑƀğěϘƄ attractive market positioning: longstanding blue 
chip client base
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2

5

A pre -eminent leader in REIB

Á9ŀǎǘŘƛƭ {ŜŎǳǊŜŘ Ƙŀǎ ƭƻƴƎǎǘŀƴŘƛƴƎ ǊŜƭŀǘƛƻƴǎƘƛǇǎ ǿƛǘƘ ǘƘŜ ǿƻǊƭŘΩǎ 
most significant and sophisticated investors and lenders in 
global real estate and alternatives

ÁProvides immediate access to deal flow and the largest and 
most sophisticated pools of global capital 

ÁEastdil {ŜŎǳǊŜŘΩǎ market position enables it to establish 
partnerships with leading investors at the earliest stages of their 
investment decision -making process

Eastdil Secured has been on 15 of the 20 largest private 
US/Europe transactions since 2021 (1) 

Eastdil {ŜŎǳǊŜŘΩǎ top 20 clients have $1.6tn (2)  of CRE assets 
under management

With a longstanding blue -chip client base

(1) Sources: MSCI Real Capital Analytics, Green Street, public filings and press releases. Data reflects asset/portfolio sale tra nsactions in the U.S. and 
Europe and excludes minority joint venture recapitalisations, public mergers, and take -private transactions.

(2) Based on public filings. 

2

Has sold the 

business 

GCP International to

~$5 Billion
Financial Advisor 

to Ares

Has been recapitalized 

into a continuation 

vehicle by

~ϵнм .ƛƭƭƛƻƴ
Financial Advisor

to Blackstone

Has acquired via a 

take private 

transaction

~$15 Billion
Financial Advisor 

to GIC

~$18 Billion
Financial Advisor

to Blue Owl

U.S. Data Center 

Construction Financing

~£1 Billion
Financial Advisor

to the Joint Venture

22 Bishopsgate

London Office 

Financing
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(1) Financials presented on a U.S. GAAP basis.
(2) Unweighted EBITDA margin average of 17%.
(3) Operating cash flow conversion calculated as Eastdil Secured cash flow from operating activities as a percentage of underlyin g E BITDA in 2025. 

Eastdil ÂğĕƑƀğěϘƄ higher - margin transactional revenues have 
delivered strong performance and robust margin despite market 
volatility 

A
C

Q
U

IS
IT

IO
N

 O
F

 E
A

S
T

D
IL

 S
E

C
U

R
E

D

25

1
2

2

2

5

Strong through the cycle revenue performance Margins averaging 18% over last 5 years

Revenue ($m) (1)

L5Y weighted average: 18% (2)
Underlying EBITDA ($m) and margin (%) (1)

Strong historical cash generation with operating cash flow conversion >100% in 2025 (3)

862

655

367

485

633L5Y average: $600m

2021 2022 2023 2024 2025

197

122

38

71

113

23%

19%

10%

15%

18%

5%

10%

15%

20%

25%

30%

0

50

100

150

200

250

300

350

400

2021 2022 2023 2024 2025

Underlying EBITDA ($m) Underlying EBITDA Margin

L5Y average: $108m
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Á Enlarged Group to offer clients a 

significantly enhanced service 

offering - minimal overlap in key 

clients

Á Key areas of expected direct 

revenue synergies include:

Á Incremental Capital Markets 

business generation in EMEA 

and the U.S. through 

combined Eastdil Secured and 

Savills capabilities

Á Provision of Leasing, Property 

Management, Building & 

Project Consultancy and 

Valuation Services to Eastdil 

Secured clients 

Á Utilising Savills leading 

footprint and relationships to 

expand Eastdil {ŜŎǳǊŜŘΩǎ REIB 

offering in APAC and joint 

mandate activity

Provides our clients with an enhanced full suite of real estate 
services, covering the whole lifecycle of real estate investment

A
C

Q
U

IS
IT

IO
N

 O
F

 E
A

S
T

D
IL

 S
E

C
U

R
E

D

26

Services available to clients Savills Eastdil Secured Enlarged Group 

Capital Markets / 
Transaction 

Advisory

Strategic Advisory & M&A ṉṉṉ ṉṉṉ

Acquisition Advisory ṉṉṉ ṉṉ ṉṉṉ

Disposal Advisory & Recaps ṉṉ ṉṉṉ ṉṉṉ

Residential Sales ṉṉṉ ṉṉṉ

Leasing ṉṉṉ ṉṉṉ

Debt Financing ṉ ṉṉṉ ṉṉṉ

Investment 
Management

ṉṉ ṉṉ

Consultancy

Valuation ṉṉṉ ṉṉṉ

Technical Due Diligence ṉṉṉ ṉṉṉ

Development / Planning ṉṉṉ ṉṉṉ

Building & Project Consultancy / Project 
Management

ṉṉṉ ṉṉṉ

Housing / Professional Services / Other ṉṉ ṉṉ

Property& 
Facilities 

Management
ṉṉṉ ṉṉṉ
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Significant cultural alignment & client - first ethos
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ÁClient focused and performance driven 
culture from the ground up across 
both businesses

ÁΨ5ŜŎŀŘŜǎ ƴƻǘ ŘŜŀƭǎΩ ƳŜƴǘŀƭƛǘȅ ƻŦ ōǳƛƭŘƛƴƎ 
long -term relationships over 
single transactions

ÁCollaborative teams with cross border 
and service line collaboration embedded 
within DNA

Á The Eastdil Secured leadership team and 
other Eastdil Secured employees will 
become 6.3% shareholders in Savills 

ÁMajority of the after -tax consideration 
received by Eastdil Secured employees 
will be in Savills equity

ÁConsideration Shares will be subject to 
lock -up provisions for 4 -6 years (1)

ÁExisting one -off Eastdil Secured SIP to 
remain in place

Á $62.5m LTIP will be established for 
relevant employees and future hires, 
with initial grants subject to 
lock -up provisions

ÁReferral protocols agreed

ÁCommitted leadership team with strong 
track record of profitable growth

ÁMichael Van Konynenburg, CEO of 
Eastdil Secured, and James McCaffrey, 
President, will both join Savills Group 
Executive Board and will lead the 
ŎƻƳōƛƴŜŘ DǊƻǳǇΩǎ w9L. ōǳǎƛƴŜǎǎ

ÁRoy H. March, Executive Chairman of 
Eastdil Secured, will continue to focus on 
client advisory, execution, and 
long -term strategy

Shared culture 
Meaningful long -term alignment 

and retention

Eastdil {ŜŎǳǊŜŘΩǎ exceptional 
leadership and senior management 

team 

(1) Further detail on lock up provisions on page 38.
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